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DATALOGIC END USER LICENSE AGREEMENT
BY DOWNLOADING OR INSTALLING THE SOFTWARE, OR BY USING DATALOGIC EQUIPMENT THAT
INCLUDES THIS SOFTWARE, YOU ARE CONSENTING TO BE BOUND BY THIS AGREEMENT. IF YOU DO
NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, THEN DO NOT DOWNLOAD, INSTALL, USE
THE SOFTWARE NOR DATALOGIC EQUIPMENT.
The following terms and conditions govern your use of the Software except to the extent that a particular program (a) is the
subject of a separate written agreement with Datalogic or (b) includes a separate “click-on” license agreement as part of the
installation and/or download process. Should a conflict arise between the provisions of the foregoing documents, the order of
precedence shall be (1) the written agreement, (2) the click-on agreement, and (3) this agreement (“Agreement”).
1. License. Subject to the terms and conditions of and except as otherwise provided in this Agreement, Datalogic S.p.A.
(“Datalogic”) and its suppliers grant to Customer (“Customer”) a nonexclusive and nontransferable license to use the specific
program modules, feature set(s) or feature(s) in object code form only as well as associated media, printed materials and
“online” or electronic documentation (the “Software”) for which Customer has paid, if required, the license fees. The Software is
licensed not sold. The license shall be subject to each of the following limitations:

Unless otherwise expressly provided in the documentation, Customer shall use the Software solely as embedded in, for
execution on, or (where the applicable documentation permits installation on non-Datalogic equipment) for communication
with Datalogic equipment owned or leased by Customer;

Customer’s use of the Software shall be limited to use on a single hardware chassis, on a single central processing unit, as
applicable, or use on such greater number of chassis or central processing units as Customer may have paid Datalogic the
required license fee; and

Customer’s use of the Software shall also be limited, as applicable and set forth in Customer’s purchase order or in
Datalogic’s product catalog, user documentation, or web site, to a maximum number of (a) seats (i.e. users with access to
the installed Software), (b) concurrent users, sessions, ports, and/or issued and outstanding IP addresses, and/or (c)
central processing unit cycles or instructions per second. Customer’s use of the Software shall also be limited by any other
restrictions set forth in Customer’s purchase order or in Datalogic’s product catalog, user documentation or web site for the
Software.
2. General Limitations. Except as otherwise expressly provided under this Agreement, Customer shall have no right, and
Customer specifically agrees not to (i) transfer, assign or sublicense its license rights to any other person, or use the Software
on unauthorized or secondhand Datalogic equipment, and any such attempted transfer, assignment or sublicense shall be void;
(ii) correct errors to or otherwise modify or adapt the Software or create derivative works based upon the Software, or to permit
third parties to do the same; or (iii) decompile, decrypt, reverse engineer, disassemble or otherwise reduce the Software to
human-readable form to gain access to trade secrets or confidential information in the Software. To the extent required by law,
at Customer's request, Datalogic shall provide Customer with the interface information needed to achieve interoperability
between the Software and another independently created program, upon payment of Datalogic's applicable fee. Customer shall
observe strict obligations of confidentiality with respect to such information.
3. Upgrades and Additional Copies. For purposes of this Agreement, “Software” shall include (and the terms and conditions of
this Agreement shall apply to) any upgrades, updates, bug fixes or modified versions (collectively, “Upgrades”) or backup copies
of the Software licensed or provided to Customer by Datalogic or an authorized distributor for which Customer has paid the
applicable license fees. Notwithstanding any other provision of this Agreement: (1) customer has no license or right to use any
such additional copies or upgrades unless customer, at the time of acquiring such copy or upgrade, already holds a valid license
to the original Software and has paid the applicable fee for the upgrade, if required; (2) use of upgrades is limited to Datalogic
equipment for which customer is the original end user, purchaser or lessee or who otherwise holds a valid license to use the
Software which is being upgraded; and (3) use of additional copies is limited to backup purposes only.
4. Proprietary Notices. Customer agrees to maintain and reproduce all copyright and other proprietary notices on all copies, in
any form, of the Software in the same form and manner that such copyright and other proprietary notices are included on the
Software. Except as expressly authorized in this Agreement, Customer shall not make any copies or duplicates or any Software
without the prior written permission of Datalogic. Customer may make such backup copies of the Software as may be necessary
for Customer’s lawful use, provided Customer affixes to such copies all copyright, confidentiality, and proprietary notices that
appear on the original.
5. Protection of Information. Customer agrees that aspects of the Software and associated documentation, including the
specific design and structure of individual programs, constitute trade secrets and/or copyrighted material of Datalogic. Customer
shall not disclose, provide, or otherwise make available such trade secrets or copyrighted material in any form to any third party
without the prior written consent of Datalogic. Customer shall implement reasonable security measures to protect such trade
secrets and copyrighted material. Software and documentation shall remain solely property of Datalogic.
6. Limited Warranty. If Customer obtained the Software directly from Datalogic, then Datalogic warrants that during the
Warranty Period (as defined below): (i) the media on which the Software is furnished will be free of defects in materials and
workmanship under normal use; and (ii) the Software will substantially conform to its published specifications. The “Warranty
Period” means a period beginning on the date of Customer’s receipt of the Software and ending on the later of (a) ninety (90)
days from the date of initial shipment of the Software by Datalogic, or (b) the end of the minimum period required by the law of
the applicable jurisdiction. The limited warranties extend only to Customer as the original licensee. Customer's sole and
exclusive remedy and the entire liability of Datalogic and its suppliers under these limited warranties will be, at Datalogic’s sole
option, repair or replacement of the Software if reported (or, upon request, returned) to Datalogic. Except as expressly granted
in this Agreement, the Software is provided AS IS and with all faults. Datalogic does not warrant that the Software is error free
or that Customer will be able to operate the Software without problems or interruptions. In addition, due to the continual
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development of new techniques for intruding upon and attacking networks, Datalogic does not warrant that the Software or any
equipment, system or network on which the Software is used will be free of vulnerability to intrusion or attack. This warranty
does not apply if the Software (a) is licensed for beta, evaluation, testing or demonstration purposes for which Datalogic does
not receive a license fee, (b) has been altered, except by Datalogic, (c) has not been installed, operated, repaired, or maintained
in accordance with instructions supplied by Datalogic, (d) has been subjected to abnormal physical or electrical stress, misuse,
negligence, or accident, or (e) is used in ultrahazardous activities. If Customer obtained the Software from a Datalogic reseller,
the terms of any warranty shall be as provided by such distributor, and Datalogic provides Customer no warranty with respect to
such Software. The Software may contain support for programs written in Java. Java technology is not fault tolerant and is not
designed, manufactured, or intended for use or resale as online control equipment in hazardous environments requiring fail-safe
performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct
life support machines, or weapons systems.
7. Disclaimer of Warranties. Except as specified in this warranty, all expressed or implied conditions, representations, and
warranties including, without limitation, any implied warranty or condition of merchantability, fitness for a particular purpose, noninfringement, satisfactory quality or arising from a course of dealing, usage, or trade practice, are hereby excluded to the extent
allowed by applicable law. To the extent that an implied warranty cannot be excluded, such warranty is limited in duration to the
warranty period.
8. Disclaimer of Liabilities. In no event will Datalogic or its suppliers be liable for any lost revenue, profit, or data, or for
special, indirect, consequential, incidental, or punitive damages however caused and arising out of the use of or inability to use
the Software even if Datalogic has been advised of the possibility of such damages. In no event shall Datalogic or its suppliers'
liability to customer, whether in contract, tort (including negligence), or otherwise, exceed the price paid by customer. The
foregoing limitations shall apply even if the above-stated warranty fails of its essential purpose.
9. Term and Termination. This Agreement is effective until terminated. Customer may terminate this Agreement at any time by
destroying all copies of Software including any documentation. Customer’s license rights under this Agreement will terminate
immediately without notice from Datalogic if Customer fails to comply with any provision of this Agreement. Upon termination,
Customer must destroy all copies of Software in its possession or control.
10. Customer Records. Customer grants to Datalogic and its independent accountants the right to examine Customer’s books,
records and accounts during Customer’s normal business hours to verify compliance with this Agreement. In the event such
audit discloses non-compliance with this Agreement, Customer shall promptly pay to Datalogic the appropriate license fees.
11. General Provisions. This Agreement shall be governed by and construed in accordance with the laws of Italy. All disputes
arising out of or in connection with this Agreement will be subject to the exclusive jurisdiction of the competent Court of the
place where Datalogic has its registered office. If any portion hereof is found to be void or unenforceable, the remaining
provisions of this Agreement shall remain in full force and effect. Except as expressly provided herein, this Agreement
constitutes the entire agreement between the parties with respect to the license of the Software and supercedes any conflicting
or additional terms contained in the purchase order.
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REFERENCES
CONVENTIONS
This manual uses the following conventions:
"DL.CODE™" refers to the Datalogic User Interface client application running on a PC.
"User” or “Installer” refer to anyone using DL.CODE.
"Device” refers to physical devices used in the reading stations: i.e. Matrix readers.
"You” refers to the System Administrator or Technical Support person using this manual to
install, configure, operate, maintain or troubleshoot a plant equipped with DL.CODE.

REFERENCE DOCUMENTATION
The documentation related to DL.CODE™ is listed below:



Device specific Help On Line
This User’s Manual

SUPPORT THROUGH THE WEBSITE
Datalogic provides several services as well as technical support through its website. Log on
to www.datalogic.com and click on the Industrial Automation links for further information:


PRODUCTS – FIXED INDUSTRIAL BARCODE READERS
Select your product from the links on the Fixed Industrial Barcode Readers page. The
product page describes specific Info, Features, Applications, Models, Accessories, and
Downloads including documentation, software drivers, and utility programs.



SUPPORT & SERVICES – INDUSTRIAL AUTOMATION
Several links from the Industrial Automation list take you to additional services such as:
Service Program which contains Maintenance Agreements and Warranty Extensions;
Repair Centers; On-Line RMA Return Material Authorizations; Technical Support through
email or phone; Downloads for additional downloads.
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1 INTRODUCTION
DL.CODE™ software is a User Interface client application that provides reading device
configuration for Stand Alone, and Master/Slave configurations. It is installed in and runs on
Windows-based PCs (usually laptops), and connection takes place through an Ethernet
TCP/IP interface.
It also provides visual monitoring of images that can be stored in an Image Database either
locally on the device or to the local or a remote PC.
DL.CODE provides PackTrack Calibration for omnidirectional reading and tracking stations
used in Logistics applications.
DL.CODE offers statistic and diagnostic information at reading station level whether the
station is made up of a single reader or several readers connected in a Master Slave
configuration.

Main Menu and Toolbar Area

Help On Line Panels

Task Area

Configuration Parameters/

Device List Area

Selected Device Information Area

Figure 1 – Main Window Areas

1.1 MAIN FEATURES
A summary of the DL.CODE main features is listed below:


Simultaneous Device Monitoring from different remote PCs



3 different access levels



User and Session Language configuration in real time



System configuration



Dynamic content and automatic page update
1
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1.2 CONFIGURATION AND MONITORING SESSIONS
Device configuration can be performed using DL.CODE running on a remote PC through a
single session. Multiple instances of DL.CODE cannot be run on a PC and once a device is
connected for configuration it cannot be accessed by another PC running DL.CODE.
However the Monitoring feature can be accessed simultaneously by several PCs running
DL.CODE.

1.3 SIMULATORS
DL.CODE has different device prototypes which can be loaded as Offline devices. This
allows offline configurations to be prepared and loaded to a device at a later time.
To load a Simulator, Click on the Offline Devices tab at the bottom of the Device List Area to
open the list of available simulators.
A Matrix 210N simulator is selected by default. To select a different reader click its Simulator
Power button icon.

Now you can double-click or drag the simulator into the Selected Device Information Area
and begin a new configuration. See Chapter 3.
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1.4 DEVICE CONFIGURATION
DL.CODE is designed to simplify standard configuration by grouping the basic functions into
three major parameter groups: Decoding, Operating Mode, and Output.

Decoding Group

Operating Mode Group

Output Group

Figure 2 – DL.CODE Configuration Groups

Each major group is sub-divided into two parts as follows:
1. Decoding:


Image Setup: this group manages the photometry for image acquisition. It contains a
Focus Calibration tool with oscilloscope for manual focusing, and most importantly
an Image Auto Setup routine to automatically set the photometry.



Code Setup: this group manages code symbology selection and configuration
including Code Filtering parameters and the ROI windowing tool. It also contains the
Code Autolearn routine to find unknown code symbologies on an acquired image.
For DPM applications it also provides an advanced DPM Autolearn routine (see chp.
11).

2. Operating Mode:


Reading Phase: this group manages the operating mode for image acquisition.



Good Read Setup: this group manages data collection: Code Collection, Code
Combination, Code Presentation, or Match Code.

3. Output:


Data Formatting: this group manages the output message to the Host.



Output Setup: this group manages the digital outputs as well as the Green/Red
Spots.
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2 INSTALLATION
2.1 DL.CODE DISTRIBUTION CONTENTS
The DL.CODE program distribution contains the following:


Complete Installation of DL.CODE



.NET Framework (if not already present)



This manual

2.2 HARDWARE REQUIREMENTS
Typical hardware requirements for a DL.CODE Client PC are:


2.00 GHz or faster microprocessor



1 GB RAM



2 GB hard disk for 64-bit machines; 1 GB hard disk for 32-bit machines



100 Base-T Ethernet



One 19" or larger monitor (optimized for 1280x1024 resolution)

2.3 SOFTWARE REQUIREMENTS




One of the following Windows Operating System:
-

Windows XP (32 or 64-bit)

-

Windows Vista (32 or 64-bit)

-

Windows 7 (32 or 64-bit)

Web Browser: Google Chrome, Mozilla Firefox, Microsoft Internet Explorer, Opera,
etc.
NOTE: The Google Chrome Web Browser is recommended for its superior
performance characteristics.

2.4 INSTALLING DL.CODE
1. On the PC that will be used for configuration, (running Windows XP, Vista, or 7), download
the DL.CODE mini-DVD .zip file. Extract the files maintaining the folder structure and run
the start.hta file to access the installation pop-up. Click on the Install DL.CODE link to run
the installation program and follow the installation procedure.
2. When the installation is complete the DL.CODE entry is created in the Start>Programs
bar under “Datalogic” as well as a desktop icon. Double-click the desktop icon to run it.

4
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3 QUICK START
To help you get started, here is an example configuration demonstrating the basic steps of
DL.CODE configuration.
To configure your device for your application using DL.CODE, the following preliminary steps
are assumed:


The reading device(s) are installed and running.



DL.CODE is installed and running (chapter 2).

3.1 DEVICE DISCOVERY
The User Interface opens and displays a list of all the devices belonging to the Local Area
Network. DL.CODE has a discovery feature to accomplish this task.

Figure 3 – Device Discovery

The discovery feature will also show devices not belonging to the LAN and display them in
grey (see Figure 3).
The following procedure will demonstrate an example configuration.
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1. First, the device must be added to the LAN by aligning its IP Address to the network. The
network administrator should provide valid LAN address(es).
2. Click on the device wrench icon
window.

to open the Device Environment Configuration

3. Change the Ethernet Settings (IP Address, Subnet Mask, Gateway Address etc.)
according to the network requirements. See also Figure 4 below.

Figure 4 - Device Environment Configuration Window

4. Click OK; the device will reappear in the list of Online Devices (in color) meaning it is now
part of the LAN and can be configured. The new IP address will also be displayed.
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5. Double-click on or drag the device icon into the Selected Device Information Area. Details
about the device will be displayed in this area.

3.2 DECODING CONFIGURATION PARAMETERS
The Decoding Configuration parameters are divided into two groups: optical/illumination
parameters called Image Setup and code definition parameters called Code Setup.

Decoding Group

7
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3.2.1

Image Setup

To begin configuration, the reader must be correctly mounted so that its Field of View covers
the application reading area.
1. From the Task Area select Open Device Configuration.
2. The Open Device Configuration window opens showing the list of currently saved
configurations (jobs) saved on the device. For new devices, the only saved job is the
Default configuration. Click OK. The device enters run mode and begins acquiring
images.

3. Place the Grade A Barcode Test Chart in the reading area. Once positioned, stop
image acquisition by clicking on the Pause button.
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4. Click the Image Setup button and then click the Image Auto Setup button to automatically
acquire the best exposure time and gain values.

5. Select the Static or Dynamic Self-Tuning option; Start Autolearn and Apply to the Image
Setup.
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NOTE: For applications having multiple lighting or code reading conditions,
up to 10 different Image Setups can be configured by adding them with the
icon.
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6. Now click on the Focus Control tab at the bottom of the window. The oscilloscope view is
shown in the bottom panel and can be used for manual focus adjustment.

The red line in the image panel above the oscilloscope must pass through the code.
Click Play to enter run mode and reposition the code.
NOTE: To enlarge the visual image of the code and the oscilloscope views,
you can drag the Focus Calibration window up and click on the zoom image
icon

repositioning it on the code.

While in run mode, manually adjust the
focus until the bars relative to the code
in the oscilloscope demonstrate their
maximum length (focus).
You can also see the visual focus on the
code view.
When focused, click Pause to stop
image acquisition.

11
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7. Click the Acquire PPI button to automatically set Image Density so that reader will
function correctly and to the fullest extent of its capabilities. This procedure is necessary
for first time installations, or if the focal distance is changed.
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NOTE: At this point it is probably a good idea to save the configuration from
temporary memory to permanent memory giving it a specific name.

8. Now place an application specific code in front of the reader and only click the Image
Auto-Setup button to register any changes in lighting or code surface contrast.
Do not repeat Focus Calibration or PPI.

13
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3.2.2

Code Setup

1. Click on the Code Setup button. By default, the Data Matrix ECC 200 symbology is
enabled. If this symbology is among those in your application it will be shown in the
image display with its code symbology name and a green box around it indicating it is
decoded.

NOTE: The large green box for each symbol indicates the code localization
area which by default is equal to the maximum FoV. It can be resized and
moved by dragging its borders with the mouse. The code must be found
within this area in order to be decoded.

2. Add your application specific codes to the Code Settings by selecting them from the icons
over the Configuration Parameters tree area. If the Data Matrix symbology is not used,
then delete it from the Code Settings with the

icon.

If you don’t know the code type you can use the Code Autolearn feature by clicking on
the

icon. See par. 4.4 for details.

3. For each code symbology set the relative parameters according to your application.
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3.3 OPERATING MODE CONFIGURATION PARAMETERS
The Operating Mode Configuration parameters are divided into two groups: Reading Phase
parameters and Good Read Setup parameters.

Operating Mode
Group

3.3.1

Reading Phase

1. Select your application specific Operating Mode from the icons over the Configuration
Parameters tree area: Continuous, One Shot, Phase Mode or PackTrack.

2. Configure the relative Operating Mode parameters from the Reading Phase parameters
panel. Different groups will appear in the panel depending on the selected icons over the
Configuration Parameters tree area.

15
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3.3.2

Good Read Setup

1. Select your specific data collection type from the icons over the Configuration Parameters
tree area: Code Collection, Code Combination, Presentation or Match Code. Not all data
collection types are available for all Operating Modes; for example PackTrack Operating
Mode only supports Code Combination. Incompatible data collection types will be shown
in grey and cannot be selected.
The following example shows Code Combination. By default, the Expected Codes (when
more than one code type is selected), are in logical AND, which means that all codes are
required to be decoded to produce a Good Read condition.

2. If a Good Read condition should be produced when any single code is decoded,
independent from the others, then they need to be combined in logical XOR. To do this,
drag the code icon(s) from their relative Expected Code box into the Expected Code box
of the XOR combination you wish to create. Then delete the empty box by selecting it
with the mouse (highlighted) and pressing the delete key on your keyboard.
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To create a logical AND condition from a logical XOR, create a new Expected Code box
using the

icon. Then drag the desired code icon from one box to the other.

3.4 OUTPUT CONFIGURATION PARAMETERS
The Output Configuration parameters are divided into two groups: Data Formatting
parameters and Output Setup parameters.

Output Group

3.4.1

Data Formatting

1. Configure your application specific Data Formatting Message(s) from the Configuration
Parameters tree area: Message 1, Message 2, etc.

17
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You can add fields to the output message by clicking on the icons above the Message Field
area. They will be appended to the message. You can drag them to position them between
other fields in the message so that the output message is ordered according to your
application requirements.
Each field has its own relative configuration parameters in the parameters panel.

3.4.2

Output Setup

1. Configure your application specific Digital Output(s) and Green/Red Spots (if used) from
the Configuration Parameters tree area: Output 1, Output 2, etc.

NOTE: Save the configuration from temporary memory to permanent
memory, overwriting the previously saved configuration.
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4 DL.CODE USER INTERFACE
4.1 DL.CODE DEVICE DISCOVERY WINDOW
After loading your specific device from the discovery window (drag & drop from the Device
Selection Area), the DL.CODE Device Discovery window presents the following principal
areas:


Main Menu and Toolbar Area – allows access to the major program functions and
commands. See par. 4.2.



Device List Area – shows all the discovered devices both on and off the LAN. The
colored icons next to the device labels indicate network status, see par. 4.1.1.
Double-clicking or dragging an available device icon onto the Device Information Area
connects it to DL.CODE for configuration.



Device Information Area – this area shows all device specific information: Name,
Model, Role, running software and version details.



Task Area – Presents a graphical list of the main features to be performed upon
device connection: create a new configuration (Stand Alone or Master/Slave), Open
an existing configuration, perform PackTrack calibration, or switch to Monitor mode.
These selections are also available in the File and Device Menus.



Control/Help Panel – In the DL.CODE opening window this panel provides a Help
description for Device Selection. Once a new or existing configuration is loaded, this
is the key area which allows all the individual device configuration parameters to be
set. Context sensitive Help is also available from this panel. See par. 4.1.2.



Status Bar – a reserved area that keeps specific information about the connected
device, SW schema revision, user level, calibration status, and program version
always visible.

Main Menu and Toolbar Area

Task Area

Control/Help Panel

Device List Area

Selected Device Information Area

Status Bar

Figure 5 – Device Discovery Window Areas
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4.1.1

Device List Area

The Device List area shows all the discovered devices both on and off the LAN. The icons
indicate the Device status as shown in the table below:

Stand Alone device connected to the network with a valid LAN IP
address. Available for configuration through DL.CODE.
Stand Alone device connected to the network with a valid LAN IP
address but currently connected to DL.CODE by another User. Not
available for configuration through DL.CODE (double-clicking or
dragging the icon has no effect).
Device connected to the network but without a valid LAN IP address
(i.e. default IP address). The IP addressing parameters must be
modified to connect to the LAN. See par. 3.1.
Offline device deactivated. Only one offline device at a time can be
activated.

Master device connected to the network with a valid LAN IP address.
Available for configuration through DL.CODE.

4.1.2

Control/Help Panel

Upon opening DL.CODE, the Device Selection
Help Page is displayed with dropdown
descriptions briefly explaining how to connect to
your device and the various configuration
selections. Click on the
icon to open the
dropdown description.

When a new configuration is created or an existing one is opened, the Control page showing
all of the configuration parameters for the selected configuration step or item is displayed in
the Help/Control area.
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By clicking on any parameter name with a hyperlink, the relative contextual help page will
open and present the specific parameter description.

Return to the
configuration page

Figure 6 – Control Panel and Relative Contextual Help Page

To return to the parameter page, click on the Control bar.
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4.2 DL.CODE MAIN MENU AND TOOLBAR
The Main Menu and Toolbar icons are located at the top of the DL.CODE window as shown
below.

The Main Menu presents the following items:
File:


Getting Started: returns to the initial Device Discovery window to load a different
device. You will be prompted to Save or Discard the current configuration.



Open: load a previously saved configuration from the device memory or from a .dlcfg
file selected from a disk/directory of your choice.



Save: save the current configuration to the device memory or to a .dlcfg file selected
from a disk/directory of your choice.



Setup Internal Network: sets the current device’s internal network Role to Master
and performs the Net Auto-set feature to automatically recognize its connected IDNET Slaves. The Internal Network Configuration window allows ID-NET configuration
management. See chapter 9 for details.



Monitor: sets the device to run mode for testing configuration results. An image
window is displayed along with Statistics, Diagnostics and a Console for output
message verification. See chapter 7 for details on using and configuring the Monitor.



Exit: exits the DL.CODE User Interface.

Options:


Change Language: allows you to change the display language used for DL.CODE in
real time. The selected language will also be used for successive sessions.



UI Settings: opens a window where various settings regarding DL.CODE
presentation on the PC. The following DL.CODE features can be configured: console
presentation, Image Buffer positioning and behavior, Simulator Settings, and
selecting which features to enable for viewing. The Monitor can also be configured
from this window by selecting the Monitor tab.



Change Log Level: allows the configuration log level to be changed between
Verbose, Information and Error.



Change User: allows the configuration access level to be changed between BasicUser (no parameters modification allowed), Basic-Installer (medium level of
parameter modification allowed) and Expert-Installer (maximum level of parameter
modification allowed).



Restore UI to Default: restores all UI panels to their default positions.

Device:
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Connect to Device: if not already connected to a device, this allows you to connect
to a device on the LAN by inputting its IP Address into the dialog box and clicking
Connect.
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Find Devices: searches for new devices connected to the LAN without disconnecting
from the current device.



Settings: opens device configuration windows for configuring Environment
parameters (see chp. 12), Advanced Configuration Settings, resetting Statistics
and/or Diagnostic counters and viewing HMP shortcuts.



Update Package: allows updating the device firmware (application program, schema,
etc.)



Change Current Configuration:



Restart Device: performs a software reset on the loaded device.



Backup/Restore: manages all the backup and restore options to and from the device
as well as restoring the default settings.



RAM Image Buffer Settings: opens the RAM Image Buffer Management window to
either save or discard images in the device’s RAM Image Buffer.



PackTrack Calibration: launches the Packtrack Calibration procedure. See chapter
10 for details.

Help:


About: opens the information window containing the DL.CODE program release
version number.



DL.CODE User’s Manual: opens this manual.

Toolbar buttons:
Getting Started: Disconnects the current device and returns to the Device
Discovery window. If the current configuration hasn’t been saved you will be
prompted to do so before disconnecting.
Find Devices: Executes a device discovery to find new or modified devices on
the LAN without disconnecting from the current device.
Open Device Configuration: Open a previously saved configuration from the
device memory. You can create a new configuration by opening a
configuration in the list and then saving it with a new name.
Save on Device: Save the current configuration to the device.
Load from PC: Open a previously saved .dlcfg configuration file from the local
PC or from a remote network location.
Save on PC: Save the current configuration to a .dlcfg file on the local PC or to
a remote network location.
Save Configuration in Temporary Memory:
Configuration/Monitor Switch: toggles between the Configuration environment
and the Monitor environment. See chp. 7 for details.
PackTrack Calibration: starts the PackTrack Calibration feature. See chapter
10.
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4.2.1

User Levels

DL.CODE has a 3-level user interface (Basic User level, Basic Installer level, Expert
Installer level).
Each level can be accessed by selecting it from the Options Menu.
The User levels have the following access rights.
Basic User: only access to the Monitor feature is given. No device configuration.
Basic Installer: a subset of program features and configuration parameters is allowed.
No Master/Slave configuration, no multiple Image Setup configuration, no Postal Codes
configuration, no Code Filter configuration, no Fieldbus configuration.
Expert Installer: access is given to all program features and configuration parameters.

4.3 IMAGE CROPPING
In some applications, the Image Cropping feature in DL.CODE can help to increase decoding
and result performance. Image cropping is performed from the Image Setup tab by clicking
on the Add Cropping Region icon as shown below.
Image cropping allows reducing the Image processing area from the full FoV to a smaller
area where codes are present. By excluding portions of the FoV, processing time is reduced.
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After clicking the Add Cropping Region icon, a blue border appears which by default is equal
to the FoV.

By dragging the edges with the mouse (resizing) you can crop the image (measured in
pixels), to a specific location where codes are present.

x,y coordinates of
upper left corner of
Cropping Region

number of pixels in
vertical Cropping
Region (Height)
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The cropped area can be moved by dragging its center.

You can also set the cropped image size and position through the Cropping Region Area
group of parameters; size = Width and Height, position = Top-Left X,Y coordinates.
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4.4 CODE AUTOLEARN FEATURE
From the Code setup page you can run the Code Autolearn feature which will recognize all
the codes present in the captured image.
1. From the Code Setup Page click on the Autolearn icon and select Code Autolearn.
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The Autolearn region (equal to the FoV) is shown in grey. You can reduce and/or move
the search area by dragging the borders or the center of the area with the mouse.
 Reducing the area can reduce the time necessary to find the code(s).
 Moving the search area allows finding specific code(s) in the image.

2. Whether the area is reduced or not, you can start the Autolearn feature by clicking on the
Autolearn icon in the display area.
Each autolearn iteration locates a single code symbology and you will be prompted to
Continue (if you need to find other codes) or to Finish.
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3. When you have located all the code symbologies, click on Finish. You will be prompted to
choose a saving selection.

4.5 DPM AUTOLEARN FEATURE
See chapter 11.
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4.6 CODE FILTERING
Code Filtering is typically done in DPM applications where the marking technique produces
module shapes or textures that can make decoding difficult. Special DPM algorithms are
provided to improve decoding as well as pre-processing Code Filters which modify the image
to compensate for defects.
The following paragraphs detail the DPM parameters used to enhance decoding capabilities.

4.6.1

DPM Algorithms

For Data Matrix family codes the Decoding Complexity parameter is available when
Processing Mode is set to Standard and selects the decoding algorithm according to the
printing/marking technique used to create the symbol and on the overall printing/marking
quality.
The possible selections progress from Low to Very High where Low can improve decoding
time for good print/mark quality and/or relatively normal size codes. This is the default
setting. Very High can improve the decode rate for low print/mark quality and/or small size
codes. This algorithm is much more aggressive but in general it may have longer decoding
times than the lower complexity algorithms. To minimize decoding time it is better to
select the lowest value that still guarantees good decoding.

Washed out and Axial
Distortion

Dot Peening On
Scratched Surface

Low Contrast
Problem

Background
Problems

Marked On Curved
Shiny Surface

Axial
distortion

Half moon effects

Shiny surface,
noisy background

Low contrast,
noisy background

Figure 7 – Problematic Direct Part Marking Examples

For QR code the Decoding Method parameter allows the Dot Peen Decoding algorithm to
be selected which improves the decode rate for low quality Direct Part Mark codes and in
general for Direct Part Mark codes with dot peening type module shapes.
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Code Filters

The following Code Filters can be applied to DPM codes to improve decoding.

Image Filter
Sets the filter to be applied to the image before being processed. This parameter can be
used to successfully decode particular ink-spread printed codes (ex. direct part mark codes).
A different filter can be applied to each Image Acquisition Setup.
The Erode Filter enlarges the image dark zones to increase readability.

Before - No Read

After - Readable
Erode

The Dilate Filter enlarges the image white zones to increase readability.

Before - No Read

After - Readable
Dilate
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The Close filter eliminates dark areas (defects) in the white zones of the image.

Before - No Read

After - Readable
Close

The Open filter eliminates white areas (defects) in the dark zones of the image.

Before - No Read

After - Readable
Open

The Contrast Stretching filter maximizes image contrast.

Before - No Read

After - Readable
Contrast Stretching
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The Histogram Equalization filter makes the gray level distribution uniform.

Before - No Read

After - Readable
Histogram Equalization

The Smoothing filter deletes small (insignificant) details in the center of the image.

Before - No Read

After - Readable
Smoothing

The Sharpening filter improves out of focus images.

Before - No Read

After - Readable
Sharpening
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The Deblurring filter improves blurred images.

Before - No Read

After - Readable
Deblurring

The Black Enhancement filter produces a nonlinear increase in the black level for light
images.

Before - No Read

After - Readable
Black Enhancement

The White Enhancement filter produces a nonlinear increase in the white level for dark
images.

Before - No Read

After - Readable
White Enhancement
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4.7 MATRIX CONTROL BY FIELDBUS CHANNEL
The Matrix reader can be controlled by signals coming from the Fieldbus Master as well as
echoing its input signals to the Fieldbus Master.

4.7.1

Fieldbus Input/Output Representation in DL.CODE

For HMS Fieldbus and the embedded Profinet-IO channels, communication with the Matrix
reader takes place through Input/Output Exchange Areas. The size of these areas is defined
in the relative parameters.
The Input and Output Exchange Area Size parameters refer to the Fieldbus Master.; Input to
the Master, Output from the Master.

Matrix Reader
(Fieldbus Slave Node)

NOTE: All other representations in DL.CODE show the fieldbus input and
output channels from the Matrix reader perspective (Fieldbus Slave Node).
Therefore fieldbus slave node Input Bits are from the Fieldbus Master and
fieldbus slave node Output Bits are to the Fieldbus Master.

35

DL.CODE USER’S MANUAL

4

4.7.2

Fieldbus Reading Phase Control

The Fieldbus Master can control the reading phase by assigning either communication
strings or individual communication bits to reading phase parameters. These bits are
received on the Matrix fieldbus channel as Input Bits.

Fieldbus String

Fieldbus Bits
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Fieldbus Digital Output Control

The Fieldbus Master can also drive the Matrix reader’s Digital Outputs by assigning either
communication strings or individual communication bits to the Digital Output Activation and
Deactivation parameters. These bits are received on the Matrix fieldbus channel as Input
Bits.

Fieldbus String

Fieldbus Bits
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4.7.4

Digital Input Echo to Fieldbus

The Fieldbus Master can receive the Matrix Reading Phase and Input signal echoes by
assigning them as sources to the fieldbus individual communication Output Bit Activation and
Deactivation parameters. These bits are sent on the Matrix fieldbus channel as Output Bits.

Input 1 echo to
Fieldbus Master on
Matrix Output Bit 0
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4.8 BACKUP AND RESTORE THROUGH DL.CODE
DL.CODE allows Backup and Restore to be performed to the configuration PC via file or to
an external storage device such as BM100.
It can be performed for Single Reader and Internal Network (Master/Slave) configurations.
Backup and Restore functions allow performing Complete Configuration and Environment
parameter storage for Single Reader and ID-NET (Master/Slave) network devices as well as
device firmware. Backup and Restore can be applied to any reader connected through a
device having external backup memory, regardless of the reader's network configuration.
Backup to and Restore from external device is supported by DL.CODE for all reading
devices when connected to:


CBX + BM100



QLM-Series Gateways
NOTE: Before executing a Backup to a BM100 backup module make sure
the Write Protection switch is set to Unlocked.
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4.8.1

Backup

To perform a Backup:
1. From the DL.CODE Device menu, select either Single Reader Backup (to file on PC); or
Backup to external storage device.
NOTE: For ID-NET network Backup, select the Backup current Internal
Network configurations selection.
You will be reminded that configuration in temporary memory will not be saved so you should
save the configuration to the reader before performing Backup.

If you are performing a backup to a file you will be asked whether to include the firmware
or not.

At the end of the backup, DL.CODE shows a message indicating successful completion.
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Restore

To perform a Restore:
1. From the DL.CODE Device menu, select either Single Reader Restore (from file on PC);
or Restore from external storage device.
NOTE: For ID-NET network Restore, select the Internal Network
replacement selection.

If restoring an ID-NET network though the Master, this may take a few minutes.

At the end of the restore, DL.CODE shows a message indicating successful completion.

4.8.3

Replacement
CAUTION: The replacement device must be the exact same model as the
device it is replacing.

The Restore function also provides easy and secure Single Device Replacement:
1. Remove the device to be replaced.
2. Connect the new device (make sure the new device has been previously set to factory
default).
3. Run the Restore procedure by selecting either Single Reader Restore (from file on PC)
or Restore from external storage device item (see: Restore procedure).

NOTE: In case of Backup or Restore operation failures, error messages will
be displayed in the Monitor Diagnostic page.
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4.9 RESTORE DEFAULTS
The device parameters are divided into two main classes, Configuration and Environment
which are affected differently by the Restore Defaults commands.


The Configuration parameters are the ones set in the various steps of the
configuration process and are specific to each application. When multiple
configurations (jobs) are saved on a single device, these parameters can be different
from one configuration to the next.



Environment parameters regard the device Identity and Position in a Network
(Ethernet, ID-NET, etc.) and are not influenced by the Default (or any other)
Configuration present in memory.

4.9.1

Restore Default Startup Configuration

The Default configuration is always present on the reader and in fact it is not modifiable and
cannot be deleted. It can always be restored by simply selecting it from the Open from
Device configuration list.

The same action can be performed from the Device menu >Backup/Restore > Restore
Defaults > Restore Default Startup Configuration. The Default Configuration will be set to
run at startup and the reader will be reset.

Any previously saved configurations on the device will remain in memory, but the Default
configuration is set as the startup configuration.
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Restore Default Environment

Restore Default Environment returns all Environment parameters to their factory default
settings. The default IP address will be restored as well as all the parameters managed in the
Device Environment Configuration window.

The Factory Default static IP address for all
Matrix N Family readers is:
IP Address = 192.168.3.100

Any previously saved configurations on the device will remain in memory, but the Default
configuration is set as the startup configuration.

4.9.3

Restore Factory Defaults

In order to return a device to its absolute Factory default parameters (for example device
replacement) it is necessary to use the Restore Factory Defaults command. You will be
prompted to confirm.
All Environment parameters will be restored to Factory default values and any existing
configurations stored on the device will be erased. The device will be reset and therefore
start in run mode with the factory default configuration.
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4.10 SOFTWARE RESET
At any time the device can be reset by the Restart Device command (
Device Menu.

) in the DL.CODE

CAUTION: Remember to save the current configuration before restarting.
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5 DATA COLLECTION METHODS
5.1 CODE COLLECTION
Valid Operating Modes: Continuous, One Shot, Phase Mode
In Code Collection mode the reader can collect several codes before providing a single
output result.
The number of codes to be collected is set by the Min Expected Codes and Max Expected
Codes.
The type of output message sent to the host depends on the No Read and Multiple Read
parameter settings and can be modified and formatted in the Data Formatting Output Group.
Example:

As shown in the figure above, the following parameters are set:
The DMECC200, CODE39 and CODE128 code types are enabled and present in the
Code Collection.
Min Expected Codes = 2; Max Expected Codes = 3; No Read is Enabled; Multiple Read is
Enabled
Case 1: two or three codes (of the enabled code types) are read
Output: the content of Message 1 Success is sent to the Host. This corresponds to a Good
Read message and by default contains the code content.
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Case 2: one code is read
Output: the content of Message 2 Failure is sent to the Host. This corresponds to the No
Read message because it doesn’t satisfy the minimum expected codes criteria.

Case 3: four codes (of the enabled code types) are read
Output: the content of Message 3 Multiple Read is sent to the Host. This corresponds to
the Multiple Read message because it exceeds the maximum expected codes
criteria.
If the Multiple Read parameter is Disabled, then Case 3 is considered a Good Read and the
content of Message 1 Success is sent to the Host containing the first three decoded codes.

In Phase Mode, by setting Analysis to Within Phase only the reading phase is considered
and a single result is provided to the user for each phase. On the other hand, by selecting
Within An Image the reader searches for the defined number of codes within each acquired
image and a result is provided to the user after each image decoding.

5.2 CODE COMBINATION
Valid Operating Modes: Continuous, One Shot, Phase Mode, PackTrack
In Code Combination mode the output results sent to the Host depend not only on the codes
read but on meeting their configured logical combination criteria.
Example:
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As shown in the figure above, the following parameters are set:
The DMECC200, QR Code and CODE128 types are enabled and present in the Code
Combination with the following logical combination:
DMECC200 OR QRCode AND Code128.
No Read is Enabled; Multiple Read is Enabled; Partial Read is treated as No Read
Case 1: codes (DMECC200 AND Code128) or (QR Code AND Code128) are read
Output: the content of Message 1 Good Read is sent to the Host. This message by default
contains the code content.
Case 2: only one of the three codes (DMECC200, QR Code or Code128) is read
Output: this is a Partial Read which, in this example, is treated as a No Read. The content of
Message 2 No Read is sent to the Host.
Case 3: all three codes (DMECC200, QR Code and Code128) or (only DMECC200 and QR
Code) are read
Output: the content of Message 3 Multiple Read is sent to the Host.
If the Multiple Read parameter is Disabled, then for Case 3:
 all three codes read (DMECC200, QR Code and Code128), is considered a Good
Read and the content of Message 1 Good Read is sent to the Host containing one of
the 2D codes (whichever was decoded first) AND Code128.
 reading (only DMECC200 and QR Code), is considered a Partial Read which, in this
example, is treated as a No Read and the content of Message 2 No Read is sent to
the Host.

In Phase Mode, by setting Analysis to Within Phase only the reading phase is considered
and a single result is provided to the user for each phase. On the other hand, by selecting
Within An Image the reader searches for the defined combination of codes within each
acquired image and a result is provided to the user after each image decoding.

NOTE: In Code Combination mode, the configured expression can contain
up to a maximum of 50 codes.
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5.3 CODE PRESENTATION
Valid Operating Modes: Continuous, One Shot
In Code Presentation mode typically a code is placed in front of the reader manually and the
successful output results are sent to the Host. Usually No Reads are disabled and the
configuration should correctly manage Multiple Reads.
Example:

As shown in the figure above, the following parameters are set:
The DMECC200, CODE128 and CODE39 types are enabled and present in the Code
Presentation:
No Read is Disabled; Code Filter Depth is 1, and multiple reads are handled by the
Acquisition Counter Threshold: Success Threshold=0, Failure Threshold=1.
Case 1: any code or combination of codes (of the enabled code types) is read in a single
acquisition.
Output: the content of Message 1 Success is sent to the Host containing one occurrence of
all of the decoded codes. This message by default contains the code content.
Case 2: any code or combination of codes is presented to the reader repeatedly
Output: this is a multiple read condition which is managed as follows:
 Success Threshold=0, the same code (by content and type) cannot be read in
successive acquisitions.
 Failure Threshold=1, the same code (by content and type) can only be read after at
least 1 acquisition without a code.
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5.4 MATCH CODE
Valid Operating Modes: Continuous, One Shot, Phase Mode
In Match Code mode the output results sent to the Host depend on whether the codes read
meet the match code criteria or not.
Example:

As shown in the figure above, the following parameters are set:
CODE39 type is enabled and present in the Match Code:
No Read is Enabled; Match Code Input is User Defined where the Expected Content =
“0*” (all codes must begin with zero but can be followed by any string – wildcard).
Case 1: a CODE39 type is read and its content begins with 0 (zero).
Output: the content of Message 1 Match Code is sent to the Host. This message by default
contains the code content.
Case 2: a CODE39 type is read but its content does not begin with 0 (zero).
Output: the content of Message 2 No Match Code is sent to the Host.
Case 3: no CODE39 type is read.
Output: the content of Message 3 No Read is sent to the Host.
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6 MESSAGE FORMATTING
Message Formatting is extremely flexible to allow a high level of customization depending on
the application requirements.
This however makes formatting more complex, so here we will break down the main
characteristics.
Information relative to code reading is transmitted in standard formats on the device’s
selected interface. We refer to this as the OUTPUT MESSAGE.
The general format of the OUTPUT MESSAGE is:
<HEADER><RESULTS><TERMINATOR>
The RESULTS component is composed of several optional fields which are used in different
combinations to create different output messages (like Successful Read, No Read, Statistical
Data, Diagnostic Data, etc.). These fields can be inserted into the output message in any
order. A list of the formatting fields is given in the table below.
Fields
Code Related

Icon

Meaning
Report various code related information types in the output message:
Code Content, Number of Characters, Code Symbology, Pixels Per Element,
Average Module Size (mils), Symbol Size, Decoding Time, X-Coordinate, YCoordinate, Angle, Slave Number, Bounding Box.
Each Code Related field can only contain one information type, but you can
include multiple Code Related fields in the output message.

Global Statistics

Include Global Statistical Counters in the output message.

Global Reading

This field offers different types of information depending on the data collection
Analysis Mode and on the Operating Mode.


When analyizing within an image, the Image Processing Time can be
included in the output message to monitor performance. Typically used
for Troubleshooting or fine tuning during installation.



For Phase mode, several phase related counters are available.



For PackTrack mode you can add the Pack ID to the output message.

Custom

Define custom strings to be included in the output message. Typically used to
customize Failure messages like No Read or Multiple Read.

Diagnostics

Monitor individual Diagnostic Failure events by including them in the output
message. Typically used for Troubleshooting.
These can also be included independently from the Code Reading events by
defining them in the Diagnostic Message. In this case they will be sent at
regular intervals depending on the defined timeout.

Code Quality Grading
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Include code quality trending to monitor print quality of code labels.
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6.1 FIELD LENGTH MANAGEMENT
All field types by default are Variable Length fields but they also support Fixed Lengths with
cutting and filling mode options.

6.2 INPUT STRINGS
All Input String fields have a table icon to the right of the field which allows you to input all
ASCII characters including non-printable characters.

Just single-click on the desired character to insert it into the string.
While it is quicker to type normal characters directly from your keyboard, non-printable
characters must be entered using the table.
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6.3 FIELD SEPARATOR
When Operating Mode is set to Code Collection or Code Presentation, the Field Separator
character or string is used to separate each formatted code message within the complete
output message #n. For example:
[Header] [formatted Code1] [Field Separator] [formatted Code2] ... [Terminator]
Each defined message #n can have a different Field Separator.
Example:
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6.4 INDEPENDENT DIAGNOSTIC MESSAGES
As a troubleshooting tool or for error monitoring a Diagnostic Message can be sent
independently from the code reading message.
For demonstration purposes, the figure below shows the Diagnostic Message for a Backup
Memory Communication Failure being monitored and sent every 3 seconds on the output
independently from the code reading output message.

Typically only the Failure string is defined to avoid unnecessary message traffic.
Only upon failures, the Failure Mask sends a fixed 32-character mask. Each character
represents the Standalone/Master device + 31 Slaves. The ASCII mask sends 0 =OK and 1
= Failure. The Binary mask sends non-printable characters.
The mask is appended to the Failure Content message (if defined).
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This monitoring could be sent to another channel so as not to interfere with data
communication, for example to another Matrix TCP Server connection, as shown below.

Several Diagnostic fields can be added to the Diagnostic Message for complete monitoring.
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6.5 CODE COMBINATION MESSAGE FORMATTING EXAMPLE
In Code Combination the expected result is always known in terms of code reading.
To simplify these examples we will not consider Code Cutting or Justification, all fields are
considered with the default value as Variable Length fields.
Recalling the example in par. 5.2:

The DMECC200, QR Code and Code128 types are enabled and present in the Code
Combination with the following logical combination:
DMECC200 OR QRCode AND Code128.
No Read is Enabled; Multiple Read is Enabled; Partial Read is treated as No Read

1. Click on the various field icons to add them to the Message Field Area to compose the
message.
You can drag them into different positions to change the ordering of the message fields.
You can also delete them by selecting the field with the mouse (highlighted in green), and
then delete it using your keyboard.

Then modify the Data Formatting parameters of each field in the parameters panel.
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The Data Formatting Parameters are:
Message 1 = Good Read
Header String = <STX>
Terminator String = <CR><LF>
Referenced Label = Expected Code 1
Code Related Field = Code Symbology
Code Related Field = Code Content
Referenced Label = Expected Code 2
Code Related Field = Code Content
Custom Field
Custom String = <Space>->Space>
Global Statistics Field
Global Info Field Type = Total Number of No Reads
Message 2 = No Read
Custom Field
Custom String = <CAN>
Message 3 = Multiple Read
Custom Field
Custom String = <?>

The Output Messages are:

Case 1: codes (DMECC200 AND Code128) or (QR Code AND Code128) are read
Output: the content of Message 1 Good Read is sent to the Host.

No Read

Multiple Read
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7 MONITOR

The Monitor feature is designed to check device operation from a remote PC even
simultaneously with other monitoring PCs.
It can be used during installation or troubleshooting to check the device operation. The
device operates with a minimum of DL.CODE overhead and therefore reading results are
much closer to real-time performance.
Monitor also provides diagnostic alarm feedback.

7.1 ACESSING THE MONITOR
You can access the Monitor page through the File menu or the Monitor icon.
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7.2 MONITORING STATISTICS
The Monitor loads with the reader in run mode and the Statistics page open. If the device is
reading (in Continuous operating mode or One Shot/Phase Mode with trigger active), the
reader will show image acquisition.
You can resize the various windows by dragging the edges with the mouse.

You can toggle between table view and chart view statistics by clicking on the icon.
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You can also switch between Session and Absolute statistics.



Session Statistics: keep track of the various reporting fields from the last session or
the last time the Statistics were reset up to the maximum Session number of reading
phases. See below. A session ends if the device is connected to the DL.CODE
configuration environment.



Absolute Statistics: keep track of the various reporting fields from the last device
power on or the last time the Statistics were reset.

7.2.1

Statistics Settings

From the Device menu > Settings > Configuration Settings you can set the number of
reading phases to monitor for a Session (from 10 to 1000).
You can also choose which fields to visualize in the Monitor Statistics page.
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You can reset all the statistics (both Session and Absolute) by selecting the Reset Statistics
command from the Device menu > Settings.
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7.3 MONITORING DIAGNOSTIC ALARMS
Any Diagnostic Alarms will show up as a warning light on the alarm panel.
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7.4 MONITOR SETTINGS
7.4.1

Monitor Images Options

Several options can be set for the Monitor
window. They are set in the Options>UI
Settings menu on the Monitor tab.
Enable Image and Results Transfer:
enables the image feedback in the Monitor
window.
Display ROI on Image: shows the bounding
box around each code on the image.
Display Phase on Image: shows the Phase
identification number in white letters in the
upper left-hand side of the image.
Image Scaling Factor: allows downsizing the image subsampling to increase the
visualization performance.

7.4.2

View Window

You can select several options to view in the Monitor window.
Console: shows the Console panel to view output messages.
Configuration: shows the Configuration panel to allow viewing the configuration parameters
(read-only).
Configuration
cannot
be
performed from the Monitor window.
Statistics/Diagnostics: shows the Statistics
and Diagnostic Alarms panels.
Automatically start Run Mode in Monitor:
when launching Monitor the window opens
with the device in Run Mode. This is the
default setting.
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8 IMAGE SAVING

8.1 DEVICE IMAGE BUFFER
The Device Image Buffer allows saving captured images to the internal device memory
(RAM) for data collection analysis. These images can either be sent to a remote or local PC
or an FTP server at run time; or they can be downloaded from the buffer when the device is
offline (not in run mode).
CAUTION: The internal device memory has a circular buffer to avoid
overrunning the available memory. To save images correctly to the internal
buffer, you need to calculate the number of images the buffer can hold
based on the image resolution for your device model.
More images can be stored in memory by scaling down the image size.

NOTE: Transferring images remotely may slightly reduce the decoding rate.
It is recommended to use this feature only when enough time is available to
guarantee the decoding of all images.

Image Saving Conditions
Maximum Depth sets the total number of images that can be sent from or saved to the
Device Image Buffer. Set this figure to a practical value taking into consideration the above
mentioned CAUTION.
Scaling Factor allows reducing the size of images to be saved so that a greater number of
images can be saved in the Device Image Buffer.
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8.1.1

Image Saving Using Matrix TCP Server/Client

To add an image saving condition to the configuration, click on the Add Image Saving
Condition icon.

When selecting a Remote Image Destination, the default value is Send Image From Matrix
TCP Server (on-board Ethernet) channel to an external TCP Client. If desired, a different
dedicated Matrix channel can be added for image transfer.
According to the selected Saving Condition parameter, after data collection analysis is
complete, images can be sent at run time directly from the Device Image Buffer to a remote
or local PC.
The Image Saving format is:
[Header] [Image Buffer] [Terminator]
The Image Buffer contains the image data in the selected format (.bmp, .jpg, .png, .tif).
If the RAW data format is selected, the Image Buffer data is preceded by 8 bytes which
indicate the image size: the first 4 bytes indicate the image columns (width) while the last 4
bytes indicate the image lines (height) in little-endian ordering.
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Image Saving Using Matrix FTP Client

Images can be sent at run time directly from the device image buffer to an external FTP
Server through a Matrix FTP Client channel. The Matrix FTP Client must be added as a new
communication channel since it is disabled by default. Do this by selecting the channel icon.




The Server Address must match the external FTP Server PC.
The Username and Password must match the ones required by the external FTP
Server PC.

Now select Images Saving and set the Send Image From parameter to Matrix FTP Client.
Input the name of the Remote Folder on the FTP Server to which the image files must be
saved.

65

8

8.1.3

DL.CODE USER’S MANUAL

Image Saving On Demand to WebSentinel FTP Server

Images can be sent to the WebSentinel FTP Server through a Matrix FTP Client channel
upon receiving a Download command from Datalogic WebSentinel™ through the Download
buttons in the Event Search tab. See the description in the Datalogic WebSentinal User's
Manual.
This selection applies only to One Shot and Phase Mode Operating Modes.

NOTE: In order for Datalogic WebSentinel to communicate with the Matrix
array you must enable WebSentinel Monitor Status in the DL.CODE
Device>Settings>Configuration Settings menu.

The Matrix FTP Client must be added as a new communication channel since it is disabled
by default. Do this by selecting the channel icon.
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WebSentinel FTP Server PC. For WebSentinel the defaults are anonymous,
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Now select Images Saving and set Send Image On to Demand and set the Send Image
From parameter to Matrix FTP Client.
Input the name of the Remote Folder on the FTP Server to which the image files must be
saved.
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8.1.4

Image Saving Using Internal Buffer

Images can be saved to the Device Image Buffer and be downloaded to a PC when the
device is offline.

To download the saved images, the device must be in offline mode. Through the Device
menu>RAM Image Buffer you can access the Image Buffer Management window.
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Upon opening this window, the images in the Device Image Buffer (RAM) are transferred to
the DL.CODE Device Image Buffer Management window and the images are deleted from
the device RAM.
You can save all the images in a zip file to the PC or you can delete the images from the
DL.CODE Image Buffer Management memory.
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8.2 UI IMAGE BUFFER
The UI Image Buffer manages the images captured through the DL.CODE Play and Capture
features.

8.3 DPM AUTOLEARN IMAGES DATABASE
The DPM Image Database allows saving images to be used by the DPM Autolearn
Calibration tool to help find the best combination of parameters for DPM applications.

See chapter 11 for details.
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9 MULTI DEVICE CONFIGURATION OPTIONS
NOTE: DL.CODE now supports several different
types using the PASS-THROUGH configuration.
allows MULTIDATA ID-NET network configurations
SYNCHRONIZED ID-NET network configurations
before.

multi device configuration
In particular this feature
to be made. Master/Slave
are also configurable as

9.1 PASS-THROUGH CONFIGURATIONS
Starting from software version 1.3.0, DL.CODE and Matrix N family readers support passthrough multi device configurations.
The pass-through configuration allows individually working devices (Alone), to collect data
from other devices (also working Alone), and pass this data to a third device through a
different communication channel. See the figure below as an example.
Alone

Alone

Alone

#1

#2

#3

CAB-ETH-M0x

Phase
Mode

Continuous
Mode

CAB-DSxx-S

External
Trigger

Power

4
2

2
3

2

Host
1

Switch
1

 = Ethernet TCP/IP Server 1
 = Ethernet TCP/IP Server 2
 = Main Serial Interface (RS232 or RS422 Full-Duplex)
 = Aux Serial Interface (RS232)
= Pass-through Input channel
= Output channel

Figure 8 – Example Pass-through Layout

The following screenshots show the configuration settings for the three devices in the
example above.
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Reader #1

Reader #2

Reader #3
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9.2 INTERNAL NETWORK CONFIGURATIONS
Internal Network configurations (also called Master/Slave configurations), are designed to
collect data from several devices connected together in an ID-NET™ network and send data
output to the Host system.
DL.CODE has a Net Autoset feature for the Internal ID-NET Network which automatically
recognizes and assigns addresses to all connected Slave readers.
In order to automatically recognize the ID-NET Slaves, all devices must be physically
installed and electrically connected (including ID-NET network wiring).
The general procedure is to:
1. Mount all the readers (mechanical and electrical installation) with factory default settings
(Layout Type = Alone, Internal Network Role = Slave).
2. Connect to the designated Master device in DL.CODE and open the Setup Internal
Network Configuration. You will be prompted to change the device to Master. Click OK.
The Slave units will automatically be recognized.
3. Depending on the application, select Multidata, Synchronized Phase Mode or
Synchronized PackTrack Configuration.

Master Configuration
First start with the desired device to assign as ID-NET Master (current default setting is
Slave). Click on Setup Internal Network Configuration from the Task area.
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You will be advised that the device role will be changed to Master.

Click OK. The Net Autoset feature automatically starts to find Slave devices connected to the
ID-NET network of the Master.

When finished, all the Slaves should have been correctly recognized. If not, verify all device
connections and power and then repeat the operation by clicking on the Start Net Autoset button.

Repeat
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Depending on the application, select one of the Default Internal Network Configurations:
Multidata, Synchronized Phase Mode or Synchronized PackTrack.

Multidata

Synchronized

This selection will open a pre-configured job for the Master reader according to the selection.
Follow the specific application instructions in the following paragraphs.
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9.2.1

Multidata ID-NET Network Configurations

The Multidata ID-NET network communications between Master and Slave are managed by
the application job (configuration) using the pass-through feature. A pre-configured job is
loaded with the correct pass-through settings for both the Master and Slaves when the
Default Multidata Configuration is selected from the Internal Network Setting feature.
1. Complete the configuration of all the application parameters (including Image Setup) and
save them to the Master with an application specific name and without the option to
Clone Master configuration on Slaves.

Figure 9 – Saving Multidata Configuration to Master

The jobs must not be cloned because the Master and Slaves have different input/output
communication channels. The readers are also working independently from each other, often
on separate stations with different code reading requirements, different operating modes, etc.
2. Connect to each Slave reader via Ethernet (see note below), and set all the configuration
parameters of each Slave device.
NOTE: If necessary, Slave device photometric (Image Setup) parameters
must be configured separately through DL.CODE. This is preferably done
through each device’s Ethernet TCP/IP channel. If Slave devices are not
connected to Ethernet you must temporarily (manually) connect them one by
one to perform Image Setup.
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Open the Slave specific application job, (the first time it has the Master Specific name).
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When the configuration opens, pause run mode and set all the application specific
configuration parameters (including Image Setup).

Verify the focus and decoding with the capture image
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3. Now save them, to a new Slave specific application job name1.

Figure 10 – Saving Multidata Configuration to Slave 1

Repeat this procedure for each Slave device until the entire network is configured.

1

An application job with the same name as the Master’s (but with Slave specific configuration parameters), has been saved to
the Slaves. Each Slave has its own configuration parameters saved in its own copy of the application job. There are no common
parameters managed by the Master for Multidata configurations.
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Example Multidata ID-NET Configuration
The Multidata ID-NET network takes advantage of the pass-through configuration to allow all
the connected readers to work independently from each other (Layout Type = Alone).
In this way data is collected over the ID-NET network and passed –through the Master to the
Host system on a different communication channel. See the figure below as an example.

Alone

Alone

Alone

ID-NET
Master

ID-NET
Slave#1

ID-NET
Slave#2
Continuous
Mode

Phase
Mode

CAB-DSxx-S

External
Trigger

2

3

Power

2

2

4

Host
CAB-ETH-M0x

1

Switch

1

 = Ethernet TCP/IP Server 1
 = ID-NET (up to 32 devices, max network extension of 1000 m)
 = Main Serial Interface (RS232 or RS422 Full-Duplex)
 = Aux Serial Interface (RS232)
= Pass-through Input channel
= Output channel

Figure 11 – Example (Pass-through) ID-NET Multidata Layout

The following screenshots show the pass-through configuration settings for the three devices
in the example above.
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ID-NET Master

ID-NET Slave #1

ID-NET Slave #2
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9.2.2

Synchronized ID-NET Network Configurations

The Synchronized ID-NET network communications between Master and Slave are internally
managed by the application software. A pre-configured job is loaded with the Synchronized
Layout Type and the correct Operating Mode for both the Master and Slaves when either the
Phase Mode or PackTrack Configuration is selected from the Internal Network Setting
feature.
1. Complete the configuration of all the application parameters (including Image Setup) and
save them to the Master with an application relative name and with the option to Clone
Master configuration on Slaves.

Figure 12 – Saving Synchronized Phase Mode Configuration to Master

2. Connect to each Slave reader via Ethernet (see note below), and set the Slave specific
parameters.
NOTE: If necessary, Slave device photometric (Image Setup) parameters
must be configured separately through DL.CODE. This is preferably done
through each device’s Ethernet TCP/IP channel. If Slave devices are not
connected to Ethernet you must temporarily (manually) connect them one by
one to perform Image Setup.
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Open the cloned application job.

83

DL.CODE USER’S MANUAL

9

When the job opens, pause run mode and configure the Slave specific parameters. These
depend on the application and include the following:


photometric parameters (Image Auto-Setup feature in the Image Setup step)



Acquisition Trigger Delays necessary to avoid lighting interference between adjacent
or oppositely positioned readers (Reading Phase step)



Images Saving if used (Data Formatting step)



Encoder Sensor: if used, (for all Slaves, the Encoder Type must be set to Internal)

Verify the focus and decoding with the capture image
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3. Now save them, overwriting the cloned application job2.

Figure 13 – Saving Synchronized Phase Mode Configuration to Slave

Repeat this procedure for each Slave device until the entire network is configured.

2

An application job with the same name as the Master’s has been cloned to the Slaves. Each Slave can have its own Image
Setup parameters saved in its own copy of the application job. Common parameters managed by the Master such as Operating
Mode cannot be modified in the Slave jobs and are shown in grey.
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Example Synchronized ID-NET Configuration
When the device is working in a Synchronized Layout Type, the ID-NET connection is used
to collect data from several readers to build a multi-point or a multi-sided reading system;
there can be one Master and up to 31 Slaves connected together.
The Slave readers are connected together using the ID-NET interface. Every slave reader
must have an ID-NET address in the range 1-31.
The Master reader is also connected to the Host on one of its communication channels. In
the following example the TCP/IP on-board Ethernet interface is used.
For a Master/Slave Synchronized layout the External Trigger signal is unique to the system;
there is a single reading phase and a single message from the Master reader to the Host
computer. It is not necessary to bring the External Trigger signal to all the readers.
In the Master/Slave Synchronized layout the Master operating mode can only be set to
PackTrack or Phase Mode.

The TCP/IP and ID-NET interfaces are connected as shown in the following figures.
3

Power

CBX100

ID-NET Synchronized
Slave#1

ID-NET Synchronized
Slave#n

ID-NET
Synchronized Master

2

 TCP/IP on-board Ethernet Interface
 External Trigger
 ID-NET (up to 16 devices - practical limit)

1

Host
Figure 14 – Example ID-NET Synchronized Layout with Master on-board TCP/IP Ethernet Interface to Host

The Master reader can be connected to the CBX series connection box with the advantage
of the Backup and Restore configuration function (CBX + BM100 module).
All devices always support multiple output channels (i.e. for data monitoring).
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Verify Master/Slave Synchronized Configuration

From the Master configuration, run the application and monitor the output data from the
DL.CODE Console or a configured channel terminal.

If necessary, as a troubleshooting tip, you can temporarily apply the Reading Mask field in
place of each Code Content field to verify if all devices are reading. To do this:
1. Connect to the Master device via Ethernet and from the Data Formatting step, change
each Expected Code Field Type from Code Content to Reading Mask.
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2. Run the application and monitor the output data from the DL.CODE Console or a
configured channel terminal.

Output Data

Reading Mask

The Reading Mask shows which device reads which Expected Code. The mask is
composed of a fixed 32-character string (0=No Read or 1=Read) representing the 32
possible readers in an ID-NET network. The Master is the last character in the string (first
character to the right). The Slaves are shown in order from right to left (1 to 31).
Example: Master + Slave 1 = 00000000000000000000000000000011
The figure above shows the Master reading Code 128 and Slave 1 reading Code 39.

3. After verifying correct functioning of the reading devices, return the Expected Code fields
from Reading Mask to Code Content.
4. If you haven’t made any other changes you can exit without saving. Otherwise, save the
Master device configuration overwriting its previous one, making sure to save without
Clone Master Configuration on Slaves, otherwise the Slave configurations will be
overwritten.
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To view the connected Slave configurations:
1. Click on the Internal Network View tab at the bottom of the screen
2. Open the Master branch by clicking on the arrow to the left of the Master icon.
3. Select any slave.
4. Click The Configuration tab at the bottom of the screen.
By selecting the various configuration steps above you can visualize the slave configuration.

NOTE: You can modify some Slave Synchronized parameters from this view
but you cannot save them here.
To save changed slave parameters here, you must click on the Master and
Save the configuration overwriting it, making sure to save without Clone
Master Configuration on Slaves, otherwise all the Slave configuration
parameters will be overwritten.

89

DL.CODE USER’S MANUAL

9

9.2.4

Alternative Device Role Selection

To set up a Master/Slave Internal Network Role you can also enter the Device Environment
settings from the Device menu>Settings>Settings and open the Internal Network Settings
group.
Change the Internal Network Role to Master or Slave accordingly.

After clicking OK you will be prompted to reset the device to be recognized as Master.

Click Yes and wait for the device to reset. It may be necessary to wait
several seconds and then perform a Discovery to refresh the device
list area. You should now see the Master device with its relative icon.
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Likewise you can set the device Internal Network Role to Slave and the Reading Point
Address (ID-NET address) according to the network configuration.

Complete the Slave configuration and save it to the device.
Complete all the ID-NET Slaves in the same way.

The Master must be set to expect the same number of slaves as foreseen by the application.
Now by simply making the electrical connections the network will be automatically
recognized upon power up.
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10 PACKTRACK CALIBRATION
PackTrack Calibration can be performed on all Standalone or Master Matrix N family readers
that support this feature.

10.1 REQUIREMENTS
The following is a list of required hardware/software that supports PackTrack for Matrix and
is necessary for performing the PackTrack Calibration.


DL.CODE release: 1.00 or later



Matrix N Standard Application Program Software: 1.00



Products: Matrix 300N™ Matrix 410N™, XRF410N™



PackTrack Calibration Pattern
CAUTION: print either the A4 or Letter size pdf file according to the
paper size you are using. Printing on the wrong size paper or rescaling the
Calibration Pattern will cause PackTrack calibration errors.



Tape Measure



These instructions

10.2 TOP CALIBRATION USING DL.CODE
CAUTION: The conveyor must be STOPPED while performing this
procedure!
NOTE: Standard Setup including optical Calibration must be completed before
performing PackTrack Calibration.
Calibration is performed using the Calibration Pattern positioned on the plane corresponding
to the tallest pack, (Near Plane, i.e. closest to the Matrix reader) and on the plane
corresponding to the shortest pack, (Far Plane, i.e. farthest from the Matrix reader).
The PackTrack Calibration is completed only after both planes have been calibrated and
saved in Flash.
NOTE: Once a completed calibration is performed, it is not possible to
perform calibration on a single plane, for example modifying one plane while
maintaining the previous parameters of the other plane. The PackTrack
Calibration always requires both steps to be completed.
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STEP 1 – Run PackTrack Calibration:
a) Select PackTrack Calibration from the toolbar icon or item in the DL.CODE Task
Area.
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b) Set the Device Position to Top from the dropdown list.

c) Click on the Calibrate button to open the Calibration Planes panel for co-ordinate
input.

STEP 2 – Determine the PackTrack System Reference Point:
a) Determine the PackTrack System Reference Point, if possible on the conveyor
frame surface, where the X, Y, Z co-ordinates = (0,0,0). Visibly mark this point on a
piece of tape or other surface, so that it can be used to make the measurements
necessary for calibration. The Y = 0 value normally corresponds to the PS Line
position.
STEP 3 – Far Plane Calibration:
NOTE: Step 3 and Step 4 can be inverted.

a) The reader should already be running (illuminator flashing and acquiring images) so
that positioning can be seen on the monitor. The pause button should be shown
indicating the reader is running.
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b) Place the Calibration Pattern so that it is completely visible in the monitor window and
it corresponds to the plane representing the lowest pack allowed to pass through the
system on the conveyor. This is the Far Plane which can also be on the conveyor
surface.
NOTE: the Calibration Pattern must be aligned so that the y-axis is parallel
to the conveyor movement direction.

c) Press the Pause button.
d) Using the tape measure, physically measure the X, Y and Z offsets from the System
Reference Point to the lower left corner of the Calibration Pattern and input this data
(mm) into the Far Plane Calibration boxes.
e) Press the Calibrate Far button for start Far Calibration.
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f)

Wait until the operation finishes. An orange progression bar runs above the Calibrate
Far button and should end in a solid green bar indicating successful calibration of the
far plane.

Possible Error Causes:
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Calibration Pattern is not completely contained in the Field of View.



Calibration Pattern is partially obscured by objects covering it
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STEP 4 – Near Plane Calibration:
NOTE: Step 3 and Step 4 can be inverted.

a) Press the Play button. The reader again begins to acquire images.
b) Place the Calibration Pattern on a pack so that it is completely visible in the monitor
window and it corresponds to the plane representing the tallest pack allowed to pass
through the system on the conveyor. This is the Near Plane.
NOTE: the Calibration Pattern must be aligned so that the y-axis is parallel
to the conveyor movement direction.

c) Press the Pause button.
d) Using the tape measure, physically measure the X, Y and Z offsets from the System
Reference Point to the lower left corner of the pack (aligned with the Calibration
Pattern) and input this data (mm) into the Near Plane Calibration boxes.
e) Press the Start button for Near Calibration.
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f)

Wait until the operation finishes. An orange progression bar runs above the Calibrate
Near button and should end in a solid green bar indicating successful calibration of
the near plane.

Possible Error Causes:


Calibration Pattern is not completely contained in the Field of View.



Calibration Pattern is partially obscured by objects covering it

In this case (first time calibration), it is possible to repeat the Near Calibration without
losing the previously completed Far Calibration.

NOTE: the items in the monitor window are still shown as “Not Calibrated”
because the calibration has not been saved yet.
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STEP 5 – Saving Calibration:
g) Click on the Apply button to save the calibration values in the reader’s flash memory.

The calibration also advises the minimum distance between packs (Min Pack
Distance), for which correct code to pack assignment can be guaranteed.
At this point PackTrack Calibration has been successfully completed.
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STEP 6 – Verify Calibration Results:
a) Place a pack, code or other object onto either the Near or Far plane at a different
coordinate from the calibration, however it must be visible in the monitor window.
b) Click on the Show Real World Coordinates icon. A green cross will appear in the
monitor window. Drag this cross with the mouse to an easy-to-measure reference
point (i.e. pack edge).
c) Using the tape measure, physically measure the X and Y coordinates from the
System Reference Point and compare them to the data shown in the monitor window
for the reference plane you are measuring.
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11 DPM CALIBRATION
11.1 PRE CONFIGURATION
Before performing DPM Calibration the reader should be pre-calibrated using the Grade A
test chart.
In addition there are several factors that require attention in order to produce the best
decoding results for DPM code reading applications.
1. The best reading results occur in static applications (no code movement during image
acquisition).
2. When using internal illumination, reduce skew angle to minimum to allow uniform lighting
on the code surface.
3. The code should be placed as close as possible to the center of the FoV.
4. Reduce reading distance to reduce ambient lighting interference.
5. The best internal illumination chain combination in part depends on the reading distance.
More light is applied to the surface at closer distances.

11.2 DPM AUTOLEARN
DL.CODE provides a DPM Autolearn Calibration tool to help find the best combination of
parameters for DPM applications. This tool is sufficient for many DPM applications, however
some particularly difficult applications may be improved by some manual calibration fine
tuning.
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11.3 DPM AUTOLEARN USING IMAGES DATABASE
DL.CODE provides a DPM Autolearn Calibration tool to help find the best combination of
parameters for DPM applications. This tool is sufficient for many DPM applications, however
some particularly difficult applications may be improved by some manual calibration fine
tuning.
1. After initial setup (Image Auto-Setup and Focusing), place the DPM code at the center of
the FoV at the same reading distance.
2. From Code Setup, click on the DPM Images Database tab at the bottom of the screen.
3. Click on the Start Recoding Images icon to start image recording.

4. When several images have been acquired, click on the Stop Recoding Images icon to
stop image recording. You will then see the images in the Image Database (saved to the
Images Database Buffer).
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5. Click on the DPM Autolearn icon to start the DPM calibration and wait until the calibration
finishes.

6. At the end of the calibration you will be prompted to Add to or Replace the Current
Configuration, or to Discard the Autolearn Result.
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Accepting the new configuration should show good decoding results in the monitor window.

11.4 DPM MANUAL CONFIGURATION
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12 DEVICE ENVIRONMENT SETTINGS
12.1 ACCESSING DEVICE ENVIRONMENT SETTINGS
To access the device environment settings obviously the device must be connected to
DL.CODE. From the Device>Settings>Settings menu open the Device Environment
Configuration window.
This window presents the following fields:
Device Name (default “Matrix”) can be
personalized by typing a new name in this field.
Startup Configuration which can be changed
by selecting a different configuration from the
dropdown list (if any).

About Device gives details about the various
software components currently loaded and
running on this device. This data is important to
know for troubleshooting purposes.

12.2 ETHERNET SETTINGS
This window presents all the Ethernet Settings
for correct device connection to the LAN.
It can also be accessed directly by clicking on
the wrench icon in the device list area as
shown in par. 3.1.
Change the Ethernet Settings (IP Address,
Subnet Mask, Gateway Address etc.) according
to the network requirements.
The Keep Alive Timeout parameter selects
the period for which a signal is sent from the
device to maintain the Ethernet connection with
the DL.CODE UI configuration environment.
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12.3 INTERNAL NETWORK SETTINGS
NOTE: All devices are pre-assigned an Internal Network Role independent
from their use. If the device is not used in an ID-NET network then this setting
can be ignored.
This window allows managing the device role in
an ID-NET network (Master or Slave).
A specific description can be typed into the
Device Description field to distinguish this
device from others in the network (i.e. a name to
indicate the device position in the network).
The ID-NET Baud Rate is selected here and
must be common to all devices in the network.
See the device Reference Manual for details on
ID-NET network configuration.

12.4 X-PRESS CONFIGURATION
This window allows managing the HMI X-PRESS™ behaviour. See the device Reference
Manual for more details on the X-PRESS features.
Configuration Status enables/disables the
X-PRESS features available through the
multifunction key on the device.
Number of Samples selects the number of
samples to analyze for the Test percentage.
Test Timeout sets when the expired timeout
causes the Test feature to exit.
Aim Timeout sets when the expired timeout
causes the Aim/Autofocus feature to exit.
Saving Options selects whether the X-PRESS
Setup and Learn features will save their results
to Permanent or Temporary memory. If set to
Permanent memory, the configuration will be
saved as the default configuration in the job list
having the Configuration Name.
Configuration Name is the name given to the configuration saved to permanent memory by
the X-PRESS Setup and Learn procedures.
Autolearn Timeout sets when the expired timeout causes the Learn feature to exit.
106

DEVICE ENVIRONMENT SETTINGS

12

12.5 PACKTRACK CALIBRATION
This window shows the PackTrack Calibration
parameter settings (read-only) for the device.

12.6 LED CONFIGURATION
This window manages the device LEDs and
Beeper behaviour.
COM LED Function selects whether the COM
LED on the device (which signals activity on the
Main Serial port) is ON when data is
transmitted by the device (TX) or received from
the Host (RX).
Beeper Status enables/disables the device
beeper.
Beeper Activation Events
events will trigger the beeper.

selects

which

Beeper Deactivation Timeout determines the
length of the beeper signal.
LEDs Deactivation Timeout determines the
length of time the LED signals are ON.
Focusing Pointer Status (for devices with laser pointers) sets the aiming system
management: Disabled - laser pointers always OFF; Always On - laser pointers always ON;
Calibration Only - laser pointers only ON during calibration procedures.
Multiple Read Treated As determines which device LED will be activated on a Multiple
Read event: Complete Read – the Good Read LED will be activated; No Read – the Status
LED will be activated.
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12.7 MAINTENANCE SETTINGS
Current Illuminator Model shows the internal
illuminator model associated with this device.
If the device is not correctly associated with its
internal illuminator incorrect functioning and/or
damage can occur. For Matrix 410N devices
see the following Illuminator Management
procedure.
PPI is the same value saved in the Image
Setup Acquire PPI image density setting
procedure. Here it can be set manually
although it is advised to use the Acquire PPI
procedure.
Enable BM100 Detection if enabled, at
startup, the reader sends a message to
recognize the presence of, and communicate
with, the External Backup Memory (BM100
Backup Module or integrated QLM-Series accessories). If using the Backup Memory, this
parameter must be enabled.

DL.CODE Illuminator Management Procedure for Matrix 410N
1. In the DL.CODE Maintenance Settings
> Current Illuminator Model item, select
the correct Illuminator being used from
the dropdown list.
2. Click OK and at the device reset prompt
click Yes and wait until the device
resets. You can confirm by reopening
this item from the same menu.
The above procedure must also be
performed before any attempt to use the
X-PRESS configuration on readers
mounting the LT-005, LT-007, LT-010 or
LT-011 illuminators.
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13 MAINTENANCE
As with nearly all electronic components, performance may drift over time making it
necessary to calibrate the device at periodic intervals for optimal reading performance. There
is a Recalibration Tool provided in DL.CODE which performs the recalibration procedure. If it
ever becomes necessary to perform this procedure, contact our Technical Support team for
assistance.
This procedure is intended to be performed by trained technicians and not performed
frequently (i.e. only after several years of operation and only if the focus level
adversely affects decoding).
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14 TROUBLESHOOTING
Problem
Device is not
displayed in the
Device Selection
Area

Cannot Configure
the Device
(parameters and
icons appear in
grey)

Solution
In order to be found by DL.CODE, Online devices must be powered
on and connected to the Local Area Network; if you don't see the
desired device within this list, please verify its connections to the
LAN and assure it is powered on; then click on the Discovery icon
to run a new device search.

The device is in run mode. Click on the Pause button
run mode.

to exit

The User is not
able to download
images

the FTP Username and FTP Password must be the same as the
ones defined in the FTP Client.

Some Images are
missing

Image availability depends heavily on the number of images
transferred and the rate of transfer, (system throughput and network
bandwidth). Since Image downloading is usually based on specific
criteria (i.e. No Read or Multiple Read conditions) the FTP Server is
adequate to handle most applications.
In extreme cases where a high throughput application requires all
images to be downloaded it is possible that some images may not be
available on the reader having been overwritten in the device's
circular buffer. See an example in the figure below.
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